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This page will describe to you a number of the drawing standards that will be required when completing your drawings in Industrial Technology - Graphics. Arrowheads shall be well defined. They may be open or solid and should comply with the forms and proportions. The length should be from 3 mm to 5 mm Lines: There are a number of different
lines that you will be required to use in Technical Drawing. The table below shows you the different lines, describes where they are used and give you an example of each line. Type of Line: Use of line in Technical Drawing: Example of lines: Type A - Continuous, Thick Visible outlines of the drawing. Type B - Continuous, Thin Dimension and
projection lines, leaders. Hatching on sections. Type C - Continuous, Thin (freehand) Break in the object. Type D - Continuous, Thin (ruled with zig-zag) Break in the object (Straight) Type E - Dashed, Thick Hidden edges. Type G - Chain, Thin Center Lines of circles, arcs and center of objects. Type H - Chain, Thick at each end and thin in the
middle. Cutting plane in sectioning of objects. Where two or more lines of different type coincide, the following order of priority should be observed: (a) Visible outlines and edges. (b) Hidden outlines and edges. (c) Cutting planes. (d) Centre-lines. (e) Projection lines. Views: Selection of views shall be selected according to the following principles:
(a) To reduce the number of views required to fully delineate the information to be specified. (b) To avoid the need for hidden outlines. (c) To avoid unnecessary repetition of detail. Sectioned views: Sectioning is used to show internal detail or to reduce the use of hidden detail lines that may make the object difficult to recognise. All hidden outlines in
the section should be omitted except in special cases. These types of drawings are Orthogonal's with imaginary lines cutting the object into parts. Each sectional view or section shall be identified with its appropriate cutting plane, where identified, by inscribing a subtitle below the view or section; e.g. ‘SECTION A-A’, ‘SECTION B-B’. Cutting planes
are to shown using a "Type H" line with the direction of viewing show by an arrowhead and a letter placed at the tail of the arrow. The cutting plane should pass through the main part of the object. Hatching: The cut part of the object is to be shown using with a hatched line (usually at 45°, unless this would make the object more difficult to
understand). Where two or more adjacent parts have been sectioned the hatch line should be at different angles. Angle of Hatching Sectioning of Adjacent components Where an object is symmetrical a part section can be used to assist in the clarity of the drawing. If the object has a web support and the section plane passes along this then the web
is not sectioned, although if the section plan passes through it then the web is sectioned (See image below). Note: In section A-A passes along the web and therefore is not hatched in the side view, although in section B-B the plane passes thought the web and is shown in the bottom view. Breaks: Break maybe used to shorten lone objects and will

use Type C or Type D lines.  Symbols: The following symbols are to be used in dimensioning: Symbol: Use: Diameter symbol, this is used to indicate the diameter of a circle. R Radius Symbol, this is used to indicate the radius of a circle or arc. This symbol is used to refer to the object being identified is square and the same size across all
surfaces. Dimensioning, Projection and Leader Lines: Objects that are drawn in Graphics often need to have dimensions showing the size and angles used to show detail about the component. Dimensions show the length and angle of items and the drawing should include only the measurements require to describe the object. Projection lines are lines
that extend from the object and extend outside the outline of the drawing where possible. These lines should start and extend past the dimension line. Dimension Lines are to be Type B lines and should be draw parallel to the direction of measurement and where possible placed outside the outline of the object. The first measurement should not be
closer then 30mm from the outline of the object, each subsequent measurement should not be closer then 20mm from previous dimension line.Dimension lines can be broken by the number although the style used must be consistent for the entire drawing.The image below describes how screw thread needs be show in a drawing. Learn about the
GrabCAD Platform Get to know GrabCAD as an open software platform for Additive Manufacturing Visit our new homepage Community Library Challenges Groups Questions Tutorials Engineers Workbench Overview Features Compare Shop Overview Features Compare Pricing Resources Blog Resource Center Help Center © 2022 GrabCAD, a
STRATASYS solution The Computer-Aided Design ("CAD") files and all associated content posted to this website are created, uploaded, managed and owned by third-party users. Each CAD and any associated text, image or data is in no way sponsored by or affiliated with any company, organization or real-world item, product, or good it may purport to
portray. When you're designing a website or app, it's always good to start by sketch your ideas on paper before you start coding. And here are some simple - but very useful - templates designed to help you.The templates are all in PDF format and available to download for free from Interface Sketch (opens in new tab). Some of them feature a grid of
dots to help with alignment when you sketch (although note that these do not represent the pixel dimensions of a specific device or browser).Download and printThe templates are hosted on Google Docs, so you'll need a Google account if you don't already have one. When you click the link, a preview of the specific template will open in your
browser.To save it to your computer as a PDF, press Ctrl+S or click the File menu and then choose the Download option.Some of the templates contain pages in landscape and portrait sizes, so when you print them out, look for the auto-rotate option in your print dialog box if necessary.Have you spotted a great free design resource? Let us know
about it in the comments below! Thank you for reading 5 articles this month* Join now for unlimited accessEnjoy your first month for just £1 / $1 /€1 *Read 5 free articles per month without a subscription Join now for unlimited accessTry first month for just £1 / $1 /€1 A3 (CHINESE SIMPLIFIED) ENGLISH FRANCAIS (FRENCH) DEUTSCH
(GERMAN) HZA&ZE (JAPANESE) PORTUGUES (PORTUGUESE) POLSKI (POLISH) PYCCKHUH (RUSSIAN) ESPANOL (SPANISH) TURKCE (TURKISH) ITALIANO (ITALIAN) (KOREAN) Each new drawing is created from a template. The default drawing template is specified by the default drafting standard set in Application Options. Use this template or
another predefined template, modify one of the predefined templates, or create your own templates to enforce conventions. Tip: To change the default drafting standard, click the Configure Default Template button on the File tab of the Application Options dialog box. Then select the desired drafting standard in the Configure Default Templates dialog
box. To create your own template, save a customized drawing file in the Templates folder. The next time you create a drawing file, the new template appears in the list of drawing templates. Your drawing template can include borders, title blocks, annotations on drawing sheets such as custom symbols, notes, revision tables, and view definitions. View
annotations and general notes are not saved in a template. Drawing templates are stored in a Templates folder specified by the current project. To find the folder location, in Autodesk Inventor, click Manage Projects. Then expand the Folder Options node in the Project list. The Templates item shows location of Autodesk Inventor template files. If the
location is [Default], place the cursor over the Templates item to display the path. Note: The Default path is specified on the File tab of the Application Options dialog box. Files that reside in the Templates folder appear on the Default tab of the New dialog box when you create new files. Files that reside in a subfolder of the Templates folder appear
on other tabs in the New dialog box. Any template can be the default template for new drawings. To make a template the default, save it in the Templates folder with the file name standard.idw or standard.dwg. To avoid overwriting the existing default template, move or rename the existing standard template before saving the new template. Tip: To
add tabs to the New dialog box, create new subfolders in the Templates folder and add template files to them. The New dialog displays a tab for each subfolder in the Templates folder. Use the Tools tab Options panel Document Settings dialog box to set the options in the templates. Specify properties such as cost center, project name, or manager,
and then save them as part of the template. Use Properties to add and maintain information automatically in title blocks, borders, sketched symbols, and text, or to track and manage files using Design Assistant. Tip: You can copy iProperties from one Autodesk Inventor file to your template by selecting Copy Model Properties, and then selecting the
desired iProperties in the Properties dialog box. Copied iProperties are not associative so do they do not update when the source file is updated. The active drafting standard specifies styles used to format dimensions, text, line weights, terminators, and other drawing annotations and properties. To ensure the correct drafting standard in all drawings,
use the Style and Standard Editor to specify the drafting standard in a template. Then set standard properties and to customize styles. Note: When using a style library, style definitions are refreshed from the library when creating a file using a template. Tip: If you use different drafting standards at different times, create one template for each
standard. The Drawing Resources folder in the Drawing browser contains folders for sheet formats, title blocks, borders, and sketched symbols that you can use to add and set up new sheets. You can customize or add to the drawing resources, and then save them in your template file. Tips: Create title block formats, custom borders, and sketched
symbols before creating the sheet formats. Copy and paste resources from the browser of one drawing to the browser of another. Rename sheet formats, borders, title blocks, or sketched symbols. Select the object to rename and slow-click the name to enclose it in an edit box, and then enter a new name. Sort the drawing resources by name in the
browser. Right-click the Sheet Formats, Borders, Title Blocks, or Sketched Symbols entry, and then select Sort by Name. Reorder the drawing resources. Drag a sheet format, border, title block, or sketched symbol and drop it at the appropriate position in the browser. To copy drawing resources from one source file to multiple destination files, use
the Drawing Resource Transfer wizard. Add a sheet format to the template for each sheet definition you need in a new drawing. After defining sheets in drawing resources, you can add them to a template. The sheets in a drawing can each be created with a different sheet format. To change the format of the first sheet in the drawing, add a sheet with
the appropriate format, and then delete the first sheet. You can add default base views or projected views to the sheet formats in a template. Use any model to add the views. The template saves the information about the standard views. When you create a file from the template, you are prompted to select the model file from which to create the views.
When you work with AutoCAD files, create a DWG template in Autodesk Inventor from a dwg file that contains the appropriate layers, blocks, title blocks, and borders. Then set the object defaults for these objects in the Style and Standard Editor . Tip: To create DWG files fully editable in AutoCAD, translate Autodesk Inventor drawings to AutoCAD
DWG format. Translation exports files more accurately and less cleanup in AutoCAD is needed. Autodesk Inventor needs a valid drawing template file when opening AutoCAD .dwg files. The default drawing template file (Standard.dwg) is located in the Templates folder. If appropriate, you can replace the default template with a customized
Standard.dwg file. When you use a template to open an AutoCAD file, all AutoCAD data is removed, except for block definitions. Any AutoCAD data that needs to remain on a sheet must be placed into a block.
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